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AutoCAD: 

 AutoCAD is a commercial computer-aided design (CAD) and drafting software application. AutoCAD is used in industry, by 
architects, project managers, engineers, graphic designers, city planners, and other professionals. 

 AutoCAD's native file formats are denoted either by a (.dwg, .dwt, .dws, or .dxf ) filename extension. 

 The primary file format for 2D and 3D drawing files created with AutoCAD is .dwg. While other third-party CAD software applications 
can create .dwg files, AutoCAD uniquely creates Real DWG files. 

AutoCAD integration: 
Autodesk has also developed a few vertical programs for discipline-specific enhancements such as: 

 Advance Steel 
 AutoCAD Architecture 
 AutoCAD Electrical 
 AutoCAD Map 3D 
 AutoCAD Mechanical 
 AutoCAD MEP 
 AutoCAD Plant 3D 
 Autodesk Civil 3D 

 

AutoCAD Logo: 



 

 

 

AutoCAD Startup Page: 

 



 

 

 



 

1. OPEN: 

2. Click File > Open > Browse. 

3. Next to the File name box, click the All Visio Files dropdown, and then select AutoCAD Drawing. 

4. Find the .dwg or. dxf file on your computer, and then double-click it to open it. The AutoCAD file will appear as a new Visio drawing. 

 

2. NEW: 
 

 
 

1. Click File > New > Dropdown Box>Select options. 

2. Acadiso.Dwt  New Model space will open. 

3. Browse templates  Saved templates file will open  Select anyone. 

4. Get More Templates online  Link: AutoCAD 2022 Templates | AutoCAD 2022 | Autodesk Knowledge Network  AutoCAD 
templates. 

 
 
 



 

Acadiso.Dwt:(New Model Space) 
 
 

 
 
 
 
 



 

 
AutoCAD 2022 windows and toolbar: 
 
 

 



 

 
       Fig.1.1-Windows and Toolbar. 

1. APPLICATION BAR: 
To access the application menu, click on the upper-left corner of the workspace. The application menu remains open as long as the cursor 
is located inside the application menu window. Ref-Image-Fig.1.2 
 



 

  

Fig.1.2- Application Menu. 

Access common tools to start or publish a file in the Application menu. 



 

Click the Application button  to do the following: 

 Create, open, or save a file 

 Audit, recover and purge a file 

 Print or publish a file 

 Access the Options dialog box 

 Close the application 

Note: You can also close the application by double-clicking the Application button. 
 
 

2. QUICK ACCESS TOOLBAR: 
 
Display frequently used tools with the Quick Access toolbar. 

 

View Undo and Redo History 

As with most programs, the Quick Access toolbar displays options to undo and redo changes to your work. To undo or redo a less recent 
change, click the drop-down button to the right of either the Undo or the Redo button. 

 



 

Add Commands and Controls 

You can easily add commonly used tools to the Quick Access toolbar by clicking the indicated drop-down button and clicking your choices from 
the drop-down menu. 

 
Tip: For a fast way to add a ribbon button to the Quick Access toolbar, right-click any button on the ribbon, and then click Add to Quick Access 
Toolbar. 

 
Buttons are added to the right of the default commands on the Quick Access toolbar. To remove one of these commands, use the CUI editor 
and open the [+] Quick Access Toolbars > [+] Quick Access Toolbar 1. From there, you can click and press Delete. You can also drag the 
elements to change their order on the toolbar. 

3. TITLE BAR: 
 
The title bar is analogous to the title bar in any Windows program. It contains the program name (AutoCAD or AutoCAD LT) and the title of the 
current drawing with its path, as long as any drawing other than the default Drawing. The Help button is a direct link to the AutoCAD help 
system 
 

 

 
 



 

 
 

4. RIBBON: 
 
The ribbon organizes tools into logical groupings. 

The ribbon provides a compact palette of all of the tools necessary to create or modify your drawing. It can be Laplace the following places: 

 Docked horizontally at the top of the drawing area (default) 

 Docked vertically along the right or left edge of the drawing area 

 Undocked, or floating within the drawing area or on a second monitor 

Ribbon Tabs and Panels 

The ribbon is composed of a series of tabs, which are organized into panels that contain many of the tools and controls available in toolbars. 

 
Some ribbon panels provide access to a dialog box related to that panel. To display the related dialog box, click the dialog box launcher is 
denoted by an arrow icon,  in the lower-right corner of the panel. 



 

 
Note: You can control which ribbon tabs and panels are displayed. Right-click the ribbon and click or clear the names of tabs or panels listed 
on the shortcut menu. 

Floating Panels 

You can pull a panel off a ribbon tab and into the drawing area or onto another monitor. The floating panel remains open until you return it to 
the ribbon, even if you switch ribbon tabs. 

 

Slide-out Panels 

If you click the arrow in the middle of a panel title, the panel will expand to display additional tools and controls. By default, slide-out panels 
automatically close when you click another panel. To keep a panel expanded, click the push pin, in the bottom-left corner of the slide-out panel. 



 

 

Contextual Ribbon Tabs 

When you select a certain type of object or start certain commands, a contextual ribbon tab is displayed instead of a toolbar or dialog box. The 
contextual tab closes when you end the command. 

 



 

Workspaces and the Ribbon 

For products that run on the Windows operating system, a workspace is a set of ribbon tabs and panels, menus, toolbars, and palettes that 
provide you with a custom, task-oriented drawing environment. You can change to a different ribbon by changing the workspace. On the status 
bar, click Workspace Switching and select the workspace you want to use. For example, here are the initial workspaces available in AutoCAD. 

 
 

5. START TAB: 
 
The Start tab is displayed by default at startup, providing easy access to a variety of initial actions, including access to drawing template files, 
recently opened drawings and sheet sets, and online and learning options. 

The Start tab contains the following pages: 

Create Page 

The following sections are displayed: 

Get Started 
Access common methods to start a file. 



 

 

Start New Drawing 
 Creates a new drawing from the default drawing template file. You specify the default drawing template file from the Options 

dialog box, Files tab, Templates, and Default Template File Name the for QNEW setting. 
 When a default drawing template file is set to None or is not specified, the new drawing is based on the most recently used 

drawing template file. 
Templates 

 Lists all the available drawing template files. 
Open Files 

 The Select File dialog box is displayed. 
Open a Sheet Set 

 The Open Sheet Set dialog box is displayed. 
Get More Templates Online 

 Download additional drawing template files when available. 
Explore Sample Drawings 

 Access the installed sample files. 

Recent Documents 
View the most recently used files. You can keep a file listed by clicking the push pin button. A pinned document is displayed at the top of the list 
until you turn off the push pin button. You can choose between image, image, and text or text only an of the display options. 

Notifications 
Displays all notifications with regards to product updates, hardware acceleration, trial period, and the help file information. A notification badge 
is displayed at the bottom of the page when there are two or more new notifications. 

Connect 
Sign in to your Autodesk account to access online services. 

Feedback: Access the online form to provide feedback and any improvements you would like to see. 

Learn Page 

The Learn page provides access to learning resources such as videos, tips, and other relevant online content or services if available. For every 
new content update, a notification badge is displayed at the bottom of the page. 



 

Note: If no internet connection is available, the Learn page is not displayed. 
 

6. STATUS BAR: 
 

 The status bar displays the cursor location, drawing tools, and tools that affect your drawing environment. 

 The status bar provides quick access to some of the most commonly used drawing tools.  

 You can toggle settings such as grid, snap, polar tracking, and object snap. You can also access additional settings for some of 
these tools by clicking their drop down-arrows.Ref.Image.Fig.1.3 

 

     Fig.1.3- Status Bar. 

 
7. VIEWCUBE 

 
The View Cube is a navigation tool that is displayed when you are working in a 2D model space or 3D visual style. With ViewCube, you can 
switch between standard and isometric views. 

The View Cube is a persistent, clickable, and draggable interface that you use to switch between standard and isometric views of your model. 
When you display the View Cube, it is shown in one of the corners of the drawing area over the model in an inactive state. The View Cube tool 
provides visual feedback about the current viewpoint of the model as view changes occur. When the cursor is positioned over the View Cube 
tool, it becomes active. You can drag or click the View Cube, switch to one of the available preset views, roll the current view, or change to the 
Home view of the model. 



 

 
Edge 

 
Corner 

 
Face 

Control the Appearance of View Cube 

The View Cube is displayed in one of two states: inactive and active. When inactive, it appears partially transparent by default so that it does 
not obscure the view of the model. When active, it is opaque and may obscure the view of the objects in the current view of the model. 

In addition to controlling the inactive opacity level of the View Cube, you can also control the following properties for the ViewCube: 

 Size 

 Position 

 Display the UCS menu 

 Default orientation 

 Compass display 

Using the Compass 

The compass is displayed below the View Cube and indicates which direction North is defined for the model. You can click a cardinal direction 
letter on the compass to rotate the model, or you can click and drag the compass ring to interactively rotate the model around the pivot point. 



 

  

 
       Fig.1.4- View Cube. 
 

8. NAVIGATION TOOLS. 
 
3D navigation tools allow you to view objects in a drawing from different angles, heights, and distances. 

Use the following 3D tools to orbit, swivel, adjust distance, zoom, and pan in a 3D view. 

 3D Orbit. Moves around a target. The target of the view stays stationary while the camera location, or point of view, moves. The target 
point displays temporarily as a small, dark sphere. The method used for locating the target point is determined by the 
ORBITAUTOTARGET system variable. 

 Constrained Orbit. Constrains 3D Orbit along the XY plane or the Z-axis. 

 Free Orbit. Orbits in any direction without reference to the planes. The point of view is not constrained along the XY plane of the Z-axis. 

 Continuous Orbit. Orbits continuously. Click and drag in the direction you want the continuous orbit to move, and then release the 
mouse button. The orbit continues to move in that direction. 

 Adjust Distance. Changes the distance of objects as you move the cursor vertically. You can make objects appear larger or smaller, and 
you can adjust the distance. 

 Swivel. Simulates panning with a camera in the direction that you drag. The target of the view changes. You can swivel the view along 
the XY plane or the Z axis. Simulates moving the camera closer to an object or farther away. Zooming in magnifies the image. 

 Pan. Starts the interactive 3D view and enables you to drag the view horizontally and vertically. 



 

 

                                                                                    
             Fig.1.4- Navigation Tool. 

9. In-Canvas View (or) View Port Controls. 

 
1. Ref. Image.Fig.1.5  Appearing at the top left corner of the drawing area on the Model "tab" (TILEMODE 1) and consuming a 

minimum of screen real estate, there are three text strings enclosed in square brackets; a left-click on one of the strings gives 
access to popup menus related to that particular view control. The first string - either a "-" (one viewport displayed) or a "+" 
(multiple viewports displayed - allows you to control the visibility of the View Cube, Steering Wheels, and Navigation Bar as well 
as access to Viewport configurations, including any custom configurations you may have created. 



 

 

 Fig.1.5- 1-View Port. 
2. Ref. Image.Fig.1.6  The second string allows you to quickly select a Model View to restore, either preset or custom, 

as well as access to the View Manager. The name of the current View direction or Model Space View (if current) is 
displayed in the second string, for easy reference while you work. 

 



 

 
   

Fig.1.6- 1-View Port. 
 
 
 
 
 
 
 
 
 
 

3. Ref. Image.Fig.1.7  The third-string displays the name of the current Visual Style, and the menu allows you to set a 
different Visual Style current (predefined or custom) or to open the Visual Styles Manager. 

 
 



 

 
 

 Fig.1.7- 1-View Port. 
 
 
 
 
 
 

10. User coordinate system. (Commanducs) 



 

 
The user coordinate system (UCS) establishes the location and orientation of a movable Cartesian coordinate system. The UCS is an essential 
tool for many precision operations. 

The UCS defines 

 The XY plane, also called the work plane or construction plane, on which objects are created and modified 

 The horizontal and vertical directions used for features like Ortho mode, polar tracking, and object snap tracking 

 The alignment and angle of the grid, hatch patterns, text, and dimension objects 

 The origin and orientation for coordinate entry and absolute reference angles 

 For 3D operations, the orientation of work planes, projection planes, and the Z-axis for vertical direction and axis of rotation 

By default, the UCS icon appears in the lower-left corner of the drawing area for the current model viewport. The UCS in each paper space 
layout is displayed as a drawing triangle. 

 
Note: A variety of colour, size, and style settings for the UCS are available from the UCSICON command. You can also turn it off when not 
needed 

 
 
 
 
 
 



 

Understand the UCS in 3D 
When you create or modify objects in a 3D environment, you can move and reorient the UCS anywhere in 3D space to simplify your work. The 
UCS is useful for entering coordinates, creating 3D objects on 2D work planes, and rotating objects in 3D. The UCS icon changes automatically 
depending on the current visual style. The colorful 3D icon on the right displays when a 3D visual style is current. 

 
Note: The UCS icon follows the traditional right-hand rule in determining positive axis directions and rotation directions. 
 
 

11. LAYOUTS 
 
Display one or more scaled views of your design on a standard-size drawing sheet called a layout. 

After you finish creating a model at full size, you can switch to a paper space layout to create scaled views of the model and to add notes, 
labels, and dimensions. You can also specify different line types and line widths for display in paper space. 

Specifying the Paper Size of a Layout 
The first thing that you should do when you access a layout tab (1) is to right-click the tab (2) and rename it (3) to something more specific than 
Layout 1. Names that reference a specific ANSI or ISO size might be a good choice. 



 

 
Next, open the Page Setup Manager (4) to change the paper size displayed in the layout tab. There are a lot of controls here, but you only 
need to change a few. The first is to specify the size of your sheet. 

 
Note: You might be wondering why there are two entries in the list for every sheet size. This is because some printers and plotters do not 
recognize the drawing orientation setting. 



 

 

Model Space and Paper Space 

As you know, you create the geometry of your model in model space. Ref. Image- Fig.1.8-1-MODEL SPACE. 

 

                                                                    Fig.1.8- 1-MODEL SPACE. 
 



 

 
                                                                                            Fig.1.9- 2-Layouts. 
 
Originally, this was the only space available in AutoCAD. All notes, labels, dimensions, and the drawing border and title block were also created 
and scaled in model space. For some applications, this method is still entirely sufficient. 

With the paper space feature, you can click a layout tab designed specifically for displaying multiple views, automatic scaling, and electronic or 
printing output. 



 

For example, a layout tab is selected in the following illustration. There are currently two objects in paper space: a block reference for the title 
and drawing border, and a single layout viewport that displays a scaled view of model space. 

Layout Viewports 
A layout viewport is an object that's created on a layout tab to display a scaled view of model space. You can think of it as a closed-circuit TV 
monitor that displays part of the model space. You can select a layout viewport as you would any other object. When you select it, several grips 
display provides vide a way to adjust the size of the viewport, move the viewport, and specify the scale of the view that's contained in it. 

 
Several editing commands such as Move, Erase, and Copy can be used on layout viewports. When you select a layout viewport, you can use 
the Properties palette to provide a complete list of options and settings. 

Tip: When you're ready to create an electronic output or print a layout, you will want to hide the viewport borders. To accomplish this, create all 
viewport objects on a separate layer and then turn that layer off. 
 

12. COMMAND LINE. 
 
The command line is one of the most unique and recognizable components of the interface. It has been there since the very earliest releases of 
AutoCAD when the program ran under the DOS operating system. The command line is where you will see instructions and options when using 
commands. 

For example, on the Home ribbon, in the Draw panel, click the Line tool. On the command line, the program prompts you to specify the first 
point of the line. Once you click to pick that point, the prompt changes. Ref. Image- Fig.1.10- Command-Line. 



 

 

 
                                                                                                     Fig.1.10- Command-Line. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

AutoCAD Layer: 

 The layer command is used to control and manage the drawings in AutoCAD for different purposes. 
 It increases the display performance of the AutoCAD by hiding the portion of our drawing when needed. It also improves the 

visual complexity of the drawing. 
 We are required to create a set of layers having different properties. For example, in a floor plan or house plan, we can 

create separate layers for doors, walls, etc. 
 We can create many layers by specifying the name for the corresponding layer. We can also control the order of the layers. 
 The shortcut command of the layer is 'LA'. 

 
The Layer on the ribbon panel looks like the below image: 
 

 
Let's discuss the layer properties in detail. 
 
Layer ON/OFF: 
It is used to turn ON or turn OFF the layer of the selected object. 
 
The layer is represented as: 



 

 
The shortcut command for the Layer ON and Layer OFF is LayON and LayOFF. 
 
Layer Isolate/Unisolate: 
The Isolate is used to hide or lock the layers. The Isolated layers are defined as visible layers. The layers are locked except for the selected 
objects. 
 
The layer is represented as: 

 
The UNISOLATE is used to unlock the layers. It is the reverse of the LAYER ISOLATE command. 
 
Layer Freeze/Thaw: 
The FREEZE is used to freeze the layer of the selected object, while the THAW is used to remove the freeze from the layer. 
The LAYER THAW unfroze the layers. 
The layer is represented as: 

 
The objects become invisible after applying the LAYER FREEZE command. 
 
Layer LOCK/UNLOCK: 
The LOCK is used to lock the layer of the selected object, while UNLOCK removes the lock from the layer. 
The layer is represented as: 



 

 
The LAYER LOCK command prevents the object from actually being modified. 
 
Current layer: 
The Current layer sets the selected layer as the current layer on the viewport. The objects will be created based on the selected current layer. 
 
The layer is represented as: 

 
Match layer: 
The MATCH LAYER is used to change the current layer to match the destination layer. The current layer is the layer of the selected objects. 
 
The layer is represented as: 

 
The other icons are listed below: 



 

 
Previous layer: 
It is used to undo the set of changes made to the settings of layers. 
 
Current layer: 
It sets the selected layer as the current layer in a drawing. The properties of the selected objects are changed to the current layer. 
 
Copy to layer: 
It is used to copy one or more objects to the other layer. 
 
Walk layer: 
The Walk Layer command is used to display the object of the selected layer while hiding the objects of the other layer. 
 
VPI layer: 
The layers in all layout viewports are frozen, except the current layer. 
 



 

Merge layer: 
It removes the previous layers from the drawing and merges the selected layers into the target layer. 
 

Delete layer: 
It is used to delete the selected layer from the layer settings or the list of layers. It also removes all the objects on that layer. 

Blocks: 
In AutoCAD, a block is a collection of objects that are combined into a single named object. The following are some sample blocks at various 
scales. 

 
Some of these blocks are realistic representations of objects, some are symbols, and one of them is an architectural title block for a D-size 
drawing. 
 

Insert a Block 
Typically, each of these blocks is an individual drawing file, perhaps saved in a folder with similar drawing files. When you need to insert one 
into your current drawing file, you use the INSERT command (or enter I in the Command window). 



 

 
The first time you insert the drawing as a block, you need to click Browse to locate the drawing file. Make sure you organize your blocks into 
easy-to-find folders. 

 
 
Once inserted, the block definition is stored in your current drawing. From then on, you can choose it from the Name drop-down list without 
needing to click the Browse button. 
Tip: The default settings in the Insert dialog box are usually acceptable. After you choose the block name, click OK, and then specify its 
location in your drawing. You can rotate it later, if necessary. 
 



 

Notice that when you insert a block, it is attached to your cursor at the point indicated. This location is called the insertion point. By default, the 
insertion point is the origin point (0,0) of the original drawing. 
 
After inserting the block, you can select it and a grip appears. You can easily move and rotate this block using this grip. 

 
In the following example, a drawing file is inserted into the current drawing to provide a standard detail view. 

 
Note: Inserting a drawing file as a block provides a static reference to the specified drawing. For a reference that automatically updates, you 
can attach the drawing with the External References palette (XREF command) instead. 

Create a Block Definition: 
Instead of creating a drawing file to be inserted as a block, you might want to create a block definition directly in your current drawing. Use this 
method if you do not plan to insert the block into any other drawing. In that case, use the BLOCK command to create the block definition. 



 

 
For example, this is how you could create a module for a cubicle design. 

1. Create the objects for the block. 
2. Start the BLOCK command. 
3. Enter a name for the block, in this case, Quad-Cube. 
4. Select the objects that you created for the block (click 1 and 2). 
5. Specify the block insertion point. 

 
You can enter the information for steps 3, 4, and 5 into the Block Definition dialog box in any order. 



 

 
After creating the block definition, you can insert, copy, and rotate the block as needed.

 
Using the EXPLODE command, you can explode a block back to its component objects if you need to make changes. In the illustration below, 
the cubicle on the right is explored and modified. 

 
In this example, you would probably create a new block definition from the objects in the exploded block. 



 

Note: You can create block definitions that include one or more attributes that store and display information. The command that you would use 
is ATTDEF. Typically, attributes include data such as part number, name, cost, and date. You can export block attribute information to a table 
or to an external file. 
 
Recommendations: 
There are several different schemes for saving and retrieving block definitions. 
 

 You can create an individual drawing file for each block that you intend to use. You save these drawing files in folders, each of which 
would contain a family of related drawing files. 

 You can include the block definitions for title blocks and common symbols in your drawing template files to make them available 
immediately when starting a new drawing. 

 You can create several drawing files, which are sometimes called block library drawings. Each of these drawings contains a family of 
related block definitions. When you insert a block library drawing into your current drawing, all the blocks that are defined in that drawing 
become available. 

  
Tip: With online access, you can download AutoCAD drawing files from the websites of commercial vendors and suppliers. This can save you 
time, but always check to make sure that they are drawn correctly and to scale. 
 
 
 
 
 
 
 

Create a Dynamic Block: 
 
Dynamic blocks contain rules and restrictions that control the appearance and behavior of a block when it is inserted into a drawing or when it's 
later modified. 

You can add these rules and controls to any existing block as well as using them when you create new blocks. The controls are limited to 2D 
operations only. 



 

Examples of Using Dynamic Blocks 

A variety of controls and behaviors are available for adding flexibility and efficiency of working with blocks. Some examples of how you could 
use dynamic blocks include the following: 

 Automatically align a block to the geometric objects that represent a wall or a pipe 

 Create additional movement grips on a block 

 Add multiple insertion points so you can cycle through them by pressing Ctrl when inserting a block 

 Choose whether a block is flipped or mirrored when inserted 

 Control the size or shape of a block to standard increments such as the length of a fastener or width of a door 

 Display a family of parts or similar styles in a tabular format to choose different versions of the same block 

If you notice an action that you commonly repeat when you work with blocks, you may be able to reduce the amount of trivial work and achieve 
substantial gains in efficiency. 

The Block Editor 
The Block Editor is a dedicated block authoring environment that lets you create and modify block geometry, attributes, and parameters, 
actions, and constraints. It includes the following components: 

 A drawing area with a gray background 

 A contextual ribbon tab that contains operations such as saving and testing the block, and exiting the editor 

 The Block Authoring palette with several tabs that contain tools to add dynamic capabilities to block definitions 

 A temporary area to test a dynamic block design 

You can access the Block Editor by using the BEDIT command, which is available on the Home tab, Block panel on the ribbon. 

Note: The third tab on the Block Authoring palette set, Parameter Sets, simply contains predefined parameters and actions that have already 
been combined for your convenience. 



 

Applying Parameter Sets 
With dynamic blocks you can insert a single block that can change its shape, size, or display instead of inserting one of many static block 
definitions. For example, instead of creating multiple interior door blocks of different sizes, you can create a single dynamic door block that can 
be resized to a doorway opening. 

 
In the previous illustration, there are several visible parameters that appear as specialized grips or controls, each of which is associated with 
an action. The highlighted custom grip is a linear parameter that's associated with a stretch action. Paired together, these are termed 
a parameter set. 

Tip: The order in which you specify key points when creating a parameter determines the location of a grip or control, and may have additional 
significance. 
Here's an example of a lookup list that provides a choice between several options. 

 
In this case, the highlighted control is a lookup parameter that's associated with a lookup action. This parameter set was designed to display a 
list of options to control the displayed swing angle of the door. 



 

Applying Constraints 
The parametric drawing feature set, which includes geometric constraints, dimensional constraints, and parametric formulas, is available for 
use in blocks. 

 
The ability to define constraints is not available in AutoCAD LT, but blocks that are defined in another AutoCAD-based product can be 
employed in AutoCAD LT without restriction. 

 
 
 
 
 
 
 
 
 
 
 

Introduction to AutoCAD Commands 
 



 

 

 
 



 

 
 

 



 

 



 

 



 

 

 



 

 

 



 

 

 



 

 



 

 

 



 

 

 
 

Hatch: 
 

 
 
 
 
 
 
 
 
 



 

 
 
 
 
 
 
 
 
 
 
 



 

 
 



 

 
 
 
 

13. General Commands 
 

In this massive list of AutoCAD commands, I have tried to include some of the most useful commands which every AutoCAD 
user must know. Some of the commands in this list are very basic commands which are used very frequently and also 
there are commands which are not often used despite their great features. 

    General Commands 

1 BCOUNT To count number of blocks 

2 TXTEXP To explode text 

3 XLINE(XL) To make infinite construction lines 

4 POINT(PO) For making points 



 

    General Commands 

5 REVCLOUD For makirevisionsion cloud 

6 SKETCH For making freehand sketch 

7 MULTIPLE To repeat a command multiple times without pressing enter 

8 NCOPY To copy nested objects from Blocks and xRef 

9 'CAL To make calculations on the command line 

10 BURST Explodes attributed block keeping attribute value retained 

11 SP Spelling check-in AutoCAD 

12 ARCTEXT To make arc aligned text 

13 OOPS Restore the last deleted object in drawing 

14 CHSPACE To change space from model space to paper space and vice versa 



 

    General Commands 

15 DIVIDE To divide an object intan o equal number of segments 

16 RENAME To rename named objects in AutoCAD 

17 BREAK To break an object into two or more segments 

18 TIME Time-related information on the drawing 

19 QSELECT For making intelligent selection sets from your drawing 

20 DI To find the distance between two points 

21 COPYBASE To copy an object from a base point 

22 PASTECLIP To paste the object from the clipboard to your drawing 

23 LIST To list most of the properties of a selected object 

24 DIM Single command to do most of the dimensioning tasks 



 

    General Commands 

25 TOLERANCE Command for entering feature control frame in the drawing 

26 SCALETEXT To change the scale of existing Text or Mtext 

27 BASE To change or assign a base point in the drawing 

28 DWGPREFIX To find the location of the saved drawing 

29 TJUST To change the justification of Text and Mtext 

30 UNITS To set the display units of the drawing 

31 ML For making multiline in AutoCAD 

32 TINSERT To insert a block or drawing in an AutoCAD table 

33 MIRRTEXT To make a mirrored copy of the f Text 

34 AREA To find the area of a closed space 



 

    General Commands 

35 TORIENT To orient selected text entities in the best readable position 

36 ID To find the coordinates of a point 

37 MINSERT Insert blocks as a rectangular array 

38 BOUNDARY Extract boundary from closed regions of the drawing 

39 DIMROTATED For making a dimension line inclined to a particular angle 

40 BREAKLINE For making a breakline symbol on the line 

41 TXT2MTXT Convert text to Mtext 

42 SAVEALL To save all open drawings 

    Performance-based commands 

43 PURGE To remove all unused objects from drawing 



 

    General Commands 

44 LAYDEL To delete stubborn layers 

45 FILLMODE To toggle visibility of filled areas like a hatch and solid fill 

46 APERTURE To change the influence region  of the object snap 

47 OVERKILL To remove redundant objects from drawings 

48 ISAVEPERCENT Change the time taken by AutoCAD to save the drawing 

49 SELECTIONPREVIEW Show or hide highlight preview when hovering the cursor over object 

50 HIGHLIGHT Show or hide highlight when the object is selected 

51 RECOVERALL Repair a drawing and it's attached xRef's 

52 LAYMCH To change the layer of one object with reference to other 

53 PICKBOX Change the size of the picked box which appears on the cursor 



 

    General Commands 

54 STARTMODE To show or hide the start tab 

55 CLOSEALL To close all open instances of the drawing 

56 SELECTIONCYCLING To cycle your selection between different overlapping objects 

57 AUDIT To remove errors from the drawing 

58 RECOVER To repair a drawing 

59 MA To match properties of one object with other 

60 CLOSEALLOTHER To close all open tabs except the current one 

61 TEXTFIT To fit the text within the selected region 

62 WIPEOUT To create a wipeout object that cleans the underlying area 

63 TEXTMASK To create automatic masking behind the text to make text legible 



 

    General Commands 

64 LAYMRG To merge multiple layers into one 

65 DS To open the drafting settings window 

66 LAYWALK To create a layer walkthrough in your drawing 

67 CENTERMARK To add a center mark on a circle or arc 

68 CENTERLINE To add a centerline between parallel or intersecting lines 

69 TABLET To use a tablet as a pointing device instead of a mouse 

    Drawing Management 

70 TEXTSCR To open the history of commands in a text window 

71 BATTMAN To modify attribute information of blocks 

72 3DCONFIG Used to change graphics related properties 



 

    Drawing Management 

73 SEEK To open an online CAD and BIM object library 

74 FS Making selections with reference to the connected objects 

75 TEXTTOFRONT To bring text, Dimensions, and Leaderlines on the top of every underlying 
object like hatches 

76 ISOLATE To hide all objects from drawing except the selected one 

77 HIDEOBJECTS To hide only selected objects 

78 GROUP To make a group of many dissimilar objects 

79 ADCENTER To open the design center palette 

80 IMPORT To import drawings of different cad formats into AutoCAD 

81 FIELD To add Fields in the drawing 

82 WBLOCK To export certain parts of the drawing as an external file 



 

    Drawing Management 

    3D Commands 

83 THICKEN To change a surface into a solid by adding thickness 

84 CONVTOSOLID To change a watertight surface or 3D mesh to solid 

85 DELOBJ Control the behavior of 2D curves when 3D tools are used 

86 VOLUME To find the volume and other solid related information 

87 REGEN3 To remove graphics related anomalies from drawing 

88 SECTIONPLANE To create a section plane on a 3D 

89 FLATSHOT To create 2D views from 3D solid 

90 INTERFERE To check the interfering parts among mating solids 

91 PROJECTGEOMETRY To project a 2D curve on a 3D surface 



 

    Drawing Management 

92 Shell (SOLIDEDIT) To create a shell or hollow shape 

93 SURFPATCH To create a closed patch on the open part of the solid 

94 HELIX To create a helix 

95 Moveface 
(SOLIDEDIT) 

To move faces like a hole or fillet 

96 SURFTRIM To trim surfaces 

97 SURFOFFSET To create offset surfaces 

98 IMPRINT To imprint 2D geometry on planar 3D objects 

99 SOLIDHIST To record the history of solids on which boolean operations are performed. 

100 3DALIGN To align a 3D object with respect to another 3D object 

  



 

SCALE 
 
Simple Scale command 
Using the scale command you can change the size of an object in AutoCAD. To explore a scale command, I will use this simple window block 
which has the size of units unit along the X-axis and 15 units altogether along the Y-axis. 

 

Select the scale tool from Modify panel of the Home tab or use its command SC. 



 

 

Now select the window drawing and press enter. Now you need to select the base point. The base point will remain fixed when the object is 
scaled, in this case, I am using the lower-left corner of the window as the base point. 

The command line will now prompt you to specify the scale factor. This scale factor determines the final size of your window. 

A scale factor of 0 to 1 will decrease the size of your object (in this case window). For example, a scale factor of 0.5 will reduce the overall size 
of your drawing to half of its original dimensions and a scale factor of 0.25 will decrease the size of the object to one-fourth of the original size. 

Similarly, a scale factor greater than 1 will increase the size of the drawing. For example, a scale factor of 2 will increase the size to twice its 
original value and a scale factor of 3 will increase the size three times. 

Enter the scale factor and press enter. In this case, I am using a scale factor of 2, the final size of the object will become 20 units along the X-
axis and 30unitst along the Y-axis. 

Additional tip: If you want to keep the original object even after changing the scale then click on the “Copy” option from the command line 
when prompted for the scale factor. 

 

Scale using reference 
Consider this scenario, we have the window used in the previous example with a length along t with the X-of axis 10 una its and height of 15 
units. Now we want to change the size of this window so that the length along the X-axis now becomeunits a unit and the height should change 
proportionally. 



 

Now, in this case, you can use the “Reference” option of the scale command to change the size of the object. 

Once again start the scale command and then select the window and press enter. Now specify the lower-left corner of the window as the base 
point, you can use any other base point as well if you want. 

Now the command line will prompt you for scale factor, on this prompt click on the Reference option from the command line. 

 

Now the command line will prompt you to specify the reference length. Type 10 and press enter, this is the current length of the window along 
the X-axis. 

Now command line will prompt you to specify the new length which you want for the 10-unit line of the window. In this case type 17 and press 
enter again. 

Now the base of the window will become 17 units in length and the height of the window will automatically change proportionally. 

As you can see, this command is quite useful if you want to change the size of an object with reference to other existing objects or any 
reference length and in this case, you obviously don’t need to specify the scale factor. 

Scaling Blocks 
The scale commands explained above will work for block references too and you don’t need to use any special property to scale blocks. 
However, you can scale your blocks with different scale factors along the X, Y, and Z-axis which I will explain here. 

I will use this drawing of a simple chair to explain this. 



 

 

First, we need to convert this simple object into a block and for that, you can use the B command. This article explains more about making a 
block in AutoCAD. 

Just make sure that while creating the block you keep the “Scale Uniformly” box unchecked as shown in the image here. 

 

Once you have your block prepared you can change the scales and then insert them into your drawing. To insert the block the e I command. 



 

Type I and press enter, and the Insert window will show up. In this window, you can assign the scale of the block the on X, Y, and Z-axis 
separately. If you keep the value of the scale the actor samthe e along the X, Y, and Z-axis then the overall size of the block will change. 

Let us use the scale factor of 1 along the X-axis and 1.5 along the Y-axis, I will keep the scale along Z-axisaxis as 1. 

 

Now click OK and click at a point to insert the block. The block will look like image B shown below where image A is the original block at the 
overall scale of 1. 



 

 

As you can see the block, in this case, will be scaled to a factor of 1.5 only in the Y direction and not in any other direction. 

 Scaling Xrefs and images 
Xrefs or external references are entities like DWG files, PDFs,s or images that can be inserted in a drawing as a reference. You can scale your 
Xrefs while inserting them or you can change their size even after inserting them into the drawing. 

For this example, I will use a DWG file, but you can use the same method for PDF files and Images. 

Type ATTACH and press enter, the attach window will open up. Select DWG from the format dropdown as shown in the image below. Now 
select the location where your file is saved then select the drawing and click on open. 



 

 

The Xref window will open up where you can assign different scales for different axes and you can even keep it at 1 for all the axes to keep the 
original size of the attached Xref. 



 

 

Even after adding the Xref, you can change its scale using the property palette. Just select the Xref from the drawing area then type PR and 
press enter. The property palette will open up, scroll down in the palette and change the scale from the geometry tab of the property palette. 



 

 

You can also use the scale command to change the overall scale of the attached Xref. 



 

Similarly, you can change the scale of attache the d images and PDF files. Here I will attach an image of the floor plan to explain it. 

Type ATTACH and press enter then select an image and click OK. Specify a point in the drawing to insert it and press enters to accept the 
default scale of 1. 

After inserting the image into my drawing, it looked like this. 

 

This image is not properly scaled ie the 10′ lengths on the image are not actually 10′ on the drawing. To fix this we need to scale this image 
again with reference to any existing dimension in the floor plan image. 

Let’s take the reference of 10′ length which is on the top of this floor plan. 



 

Type SC and press enter to start the scale command. Now select the floor plan image and press enter again. Click on the top left corner of the 
image as the base point and then select the reference option from the command line. 

Now click at point A than point B (refer to the image below) to specify the reference and type 10′ and press enter again. Now the distance AB 
on the image will change to 10′ and other distances will adjust accordingly. 

 

In this case, I have used Architectural units so make sure you change the unit to architectural before using the scale option in this example. To 
change it to Architectural type UN press enter and then select Architectural the rom Length drop-down as shown in the image here. 



 

 

Scaling Hatches 
When you add hatches in any closed area it may appear like a solid pattern, or it may not appear at all. Often this happens because of the 
improper scale of hatches which can be easily adjusted from the hatch creation panel to make them look right. 



 

Start hatch command from the Draw panel or use its command H. A temporary hatch creation tab will show up. Select the hatch pattern and 
then specify the area where you want to add the hatch. 

If the size of the hatch pattern is very small or very large, then change its scale from the scale field of the properties panel as shown in the red 
box of the image below. 

 

If the pattern is very small, then you need to increase the value in the scale field and if the pattern is widely spaced then you need to decrease 
the scale value. Here is how my ANSI 31 hatch pattern looks on a scale of 1, 0.05, and 50. 

 

Even after adding the hatches if you select them again, it will open the hatch creation tab from where you can again modify the hatch scale or 
other properties. 



 

You can also change the hatch scale from the property palette, just select the hatch pattern, then type PR and press enter. This will open the 
property palette, scroll down to the Pattern section and change the scale as shown in the image below. 

 



 

Scaling Viewports 
Drawings are often made in model space but text, title bl,ocks, and other required information related to the drawing are generally added to the 
layout or paper space. In this section, I will explain methods of creating viewports in paper space and changing their scale to fit the drawing. 

I am using this simple elevation drawing to explain this feature. 

 

This drawing is in model space but we will insert this one in viewports of different scales in the layout. Start by selecting Layout 1 from the 
bottom left tabs, you can also hit the + icon to make a new layout tab. 



 

 

The layout space will open up with a default viewport and your model space drawing will be automatically added to it. Delete the existing 
viewport and then click on the Page Setup option from the Layout tab as shown in the image here. 

 

Click on Modify button in the page setup manager window and change the settings of the layout like printer/plotter and page size. I have 
selected DWG to PDF.pc3 in the plotter and ANSI A as the paper size. 

After making these changes click OK to exit all open windows. Now we are all set to make our viewports. 

Type -VPORTS and press enter (don’t forget to add the dash before vports). Now click at a point close to the top left of the layout well within 
the plotter margin and then click at another point to make a rectangular viewport. Repeat the command and make two more rectangular 
viewports in the same layout view. 

After making all the viewports your layout space should look like this. 



 

 

Currently, the scale of drawing inside the viewport is automatically set by AutoCAD but you can change it manually. To change the scale select 
the viewport boundary then change the scale from the scale option of the status bar as shown in the image here. 



 

 

If the scale which you want to use is not available in this list of viewport scales then you can add your custom scale too. To add the custom 
scale select any viewport then click on the scalthe e option from the status bar as shown in the image above and select the Custom option from 
the list of scales. 

The “Edit Drawing Scales” window will open up. Let’s assume that we want to add a scale of to6 in this list, for that click on add button. 



 

 

In the name field of the next window add 1:6 and then add 1 in the paper unit and 6 in the drawing unit field. Click OK to accept the changes 
and close all open windows. 

You will notice that your new scale is now added to the list and you can now use it in your viewports. You can also watch the video shown 
below to know more about scaling drawings in paper space or layouts. 

 
 
 



 

 
Tool Palettes: Exploring the Features and Benefits 
 

Tool palettes provide you with a combined method of accessing tools. Whether you prefer ribbons or toolbars, tool palettes provide the best of 
both worlds. Tool palettes can consist of commonly used blocks, hatch patterns, and commands. AutoCAD comes with many default tool 
palette categories that can be expanded or customized, allowing you to create one for your own needs. As with other palettes, you can dock 
the tool palettes or have them float within your workspace or even another monitor. Tool palettes can also be shared by exporting/importing 
to/by other users and can be grouped like directories to provide you with even more flexibility and organization. 

 

Commands 

One type of tool palette is frequently used commands. Sure, there are many ways and locations to access commands: You can use the 
Command Window, ribbons, pull-down menus, the CUI dialog box, and more. However, creating a tool palette of commands allows you to store 
some of your most-used commands in one location. You can even create flyout commands that combine multiple commands from one location 
and manipulate properties (and even images) associated with commands. 



 

 

Hatching 

Hatch patterns can also be saved as a palette. Whether you need a predefined pattern or gradient hatch, simply select the hatch pattern you 
want and drag it inside the area you wish to hatch. Again, you can modify properties for each pattern. For example, if you are hatching areas 
within a plan view and have multiple patterns and scales, you could run the hatch command and modify your settings each time you changed a 
pattern, adding many additional clicks to achieve what you need. With tool palettes, create the pattern once, save it as a palette, and then drag 
and drop it to other areas. This cuts down on how many clicks of the mouse you have to make, making you more productive. 



 

 

Blocks 

The most common use for tool palettes is blocked. Instead of searching through multiple directories or libraries, you can create palettes and 
palette groups for each set of blocks. The main advantage of tool palette blocks is the property options. For example, if a palette is created 
consisting of multiple types of pipe fittings, I can establish within the palette property to insert each fitting as a block or Xref. You can establish a 
set scale, prompt to rotate, explode, etc. These options are held within each block property option. However, the properties set in the tool 
palette do not affect the block itself. This allows you to customize blocks as you need to, but will not affect other users. 



 

 

Creation of Tool Palettes 

One of the many benefits of tool palettes is how easy they are to create and organize. When you have libraries of blocks that you have created, 
use the Design Center to create a tool palette in one step. As shown in the image below, simply go to the directory with your blocks, right-click, 
and choose to create a tool palette. As you get more familiar with creating tool palettes, they can also be customized and grouped, giving you 
even more flexibility. 



 

 

For many of us who use AutoCAD, the main objective is to produce accurate, precise drawings and models as quickly and efficiently as 
possible, and tool palettes are a great way to do just that. Tool palettes give you a proverbial one-stop shop for commonly used features within 
AutoCAD. Learning the core functions is just the beginning. See the reference links below, to gain more knowledge and understanding of why 
tool palettes should be used within AutoCAD. 

 
 
 
 



 

 
External Reference ("Xref") 
 
"External Reference" ("Xref") is just fancy AutoCAD-speak for a document you attach to a drawing. When you Xref a file into your drawing, you 
are doing the digital equivalent of what drafters did decades ago: laying a piece of tracing paper (your drawing) over an existing site base, 
planting plan, or any other document you would need as a basis for your site plan. 

You can Xref several document formats into a CAD drawing. Perhaps the most common format for Xref is another DWG file. (As you likely 

know, DWG is the file format of CAD drawings.) 

To begin working with Xrefs, type Xref in the Command line and press Enter to open the Xref Manager (pictured throw). 

 

 
 



 

Note: Before Attaching an Xref: Make Sure the Units are Set Correctly. 
 

For an Xref to place and scale correctly with your main drawing, the Xref's Units setting needs to match the units and system of measurement 

(e.g., Architectural Inches, Decimal Feet, etc.) in which the Xref was originally drawn. 

To verify the unit setting, open the Xref. Type Units in the Command line, and press Enter. 

  

 
In the Drawing Units dialog box, make sure the unit Type and Insertion Scale settings match the units and measurement system in which 

that file was drawn. 

For example, if it was drawn in Imperial units in Decimal Feet, the Type menu should be set to Decimal, and the Insertion Scale menu should 

be set to Feet. 



 

 

 

 

The Unitless Setting (Options Dialog Box) 
  
We highly recommend that you set both Insertion Scale menus to Unspecified - Unitless in the User Preferences tab of the Options dialog 

box. 

(Open the Options dialog box by typing Options in the Command line and pressing Enter.) 



 

 
 This option will prevent scaling issues should you need to Xref a drawing that was produced with the units set to Unitless 

Equally Important! Clean Your Xrefs Before Attaching Them 

Attaching an Xref 
 



 

 
 

 To begin Xrefing a DWG file into your drawing, click the DWG button in the top left corner of the Xref Manager. 

 Do not see a DWG button? Your Xref Manager might have another file format enabled. 

 Click the small triangle in the top left corner of the Manager and select Attach DWG from the menu that opens. 



 

 
  
  
  



 

 
 In the Select Reference File dialog box, navigate to the DWG you want to attach. 

 Click Open to attach the DWG you selected. 

 The Attach External Reference dialog box will open. 

 Click OK to attach the DWG file. 



 

 
  
  
  



 

 
The file will be Xrefed into your drawing. 

You should now see an entry for it in the Xref Manager. 



 

  
Internet Transmission: 
 

 Find 
The Create Transmittal dialog box is displayed. 

If you enter -ETRANSMIT at the Command prompt, options are displayed. 

When you select a set of drawing files in a transmittal package, it automatically includes all related dependent files such as xrefs and font files. 



 

 
Publishing Layouts: 
 
Publishing provides a streamlined alternative to plotting multiple drawings by providing compressed representations of drawings in a file that is 
easy to view and distribute. 

An electronic drawing set is the digital equivalent of a set of plotted drawings. You create an electronic drawing set by publishing drawings to a 
DWF, DWFx, or PDF file. 

You can publish an entire sheet set from the Sheet Set Manager. With one click, you can create an electronic drawing set by publishing the 
sheet set to a single, multi-sheet DWF, DWFx, or PDF file. 



 

You can create a paper drawing set by publishing the sheet set to the plotter named in each sheet's page setup. 

Using the Publish dialog box, you can assemble a collection of drawings to publish and save the list as a Drawing Set Descriptions (DSD) file. 
You can customize this collection of drawings for a specific user, and you can add and remove sheets as a project evolves. Once you've 
created a list of drawing sheets in the Publish dialog box, you can publish the drawings to any of the following: 

 The plotter named in each sheet's page setup (including drawings that you want to plot to file) 

 A single, multi-sheet DWF or DWFx file containing both 2D and 3D content 

 A single, multi-sheet PDF file containing 2D content 

 Multiple single-sheet DWF or DWFx files containing both 2D and 3D content 

 Multiple single-sheet PDF files containing 2D content 

Using 3D DWF publishing, you can create and publish DWF files of your 3D models and view them with Autodesk Design Review. 

 



 

 



 

Plot (or) Print Drawing: 

1. Click Output tab Plot panel Plot.  Find 

 

2. Select a plotter. 

3. Select paper size, plot area, plot scale, orientation, and other options. 



 

4. For additional options, click the More Options button. 

How to select options and specify preferences for general drawing settings. 

1. Click the Application button  > Options. 

2. In the Options dialog box, click a tab and set options as desired. 

3. Save the settings: 

o To save the settings and keep working in the dialog box, click Apply. 

o To save the settings and close the dialog box, click OK. 

 
 



 

 
 

Conclusion 
  
  
 The use of the import function in Auto CAD definitely has some advantages.  It can help to reduce the 
time it takes to produce the drawings needed in the work environment.  However, if the individual that 
has created the imported file does not receive credit for their work, problems may arise in the future.  As 
well, by using the function people may slowly start to place a lesser value on the intellectual property of 
others, which will undoubtedly create future conflict.  The use of the import function may also be relied 
on heavily to create efficiencies within the industry.  This could lead to a decrease in the rate of 
innovation.  It's obvious that the import function has a place in the building industry, but its use 
will have to be regulated in order to create a balance between the negative and the positive effects it 
creates. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 
 
 
 
 
 
 
 
 

 


